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®
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registered trademarks and Ball-in-the-Box™, F Series™, FSD™, and LWD™ are trademarks 
of Digital Control Incorporated. Bluetooth is a registered trademark of Bluetooth SIG Inc. 

Patents 

U.S. and foreign patents apply to the product covered by this manual. For details, please visit 
www.DigiTrak.com/patents. 

Limited Warranty 

All products manufactured and sold by Digital Control Incorporated (DCI) are subject to the 
terms of a Limited Warranty. A copy of the Limited Warranty is included at the end of this 
manual; it can also be obtained by contacting DCI Customer Service, 425-251-0559 or 
800-288-3610, or at www.DigiTrak.com. 

Important Notice 

All statements, technical information, and recommendations related to DCI products are 
based on information believed to be reliable. However, DCI does not warrant or guarantee 
the accuracy or completeness of such information. Before using any DCI product, the user 
should determine the suitability of the product for its intended use. All statements herein refer 
to DCI products as delivered by DCI for use with horizontal directional drilling in the ordinary 
course, and do not apply to any user customizations, third-party products, or any usage of the 
DCI product outside of the ordinary course. Nothing herein shall constitute a warranty by DCI 
nor will anything herein be deemed to modify the terms of DCI’s existing Limited Warranty 
applicable to all DCI products. DCI may update or correct the information in this manual from 
time to time. You may find the most recent version of this manual on DCI's website, 
www.DigiTrak.com. Under Service & Support, click Documentation and select from the 
Manuals drop-down menu. 

Compliance Statement 

This equipment complies with Part 15 of the Rules of the FCC and with Industry Canada 
license-exempt RSS standards and with Australia Class License 2000 for LIPD (low 
interference potential devices). Operation is subject to the following two conditions: (1) this 
equipment may not cause harmful interference, and (2) this equipment must accept any 
interference received, including interference that may cause undesired operation. DCI is 
responsible for FCC compliance in the United States: Digital Control Incorporated, 19625 
62nd Ave S, Suite B103, Kent WA 98032; phone 425-251-0559 or 800-288-3610 (US/CA). 

Changes or modifications to any DCI equipment not expressly approved and carried out by 
DCI will void the user’s Limited Warranty and the FCC’s authorization to operate the 
equipment. 

CE Requirements 

  DigiTrak receivers are classified as Class 2 radio equipment per the R&TTE 
Directive and may not be legal to operate or require a user license to operate in some 
countries. The list of restrictions and the required declarations of conformity are available on 
DCI’s website, www.DigiTrak.com. Under Service & Support, click Documentation and 
select from the CE Documents drop-down menu. 

http://www.digitrak.com/patents
http://www.digitrak.com/
http://www.digitrak.com/
http://www.digitrak.com/


DIGITAL  CONTROL  INCORPORATED  

DigiTrak DataLog/LWD™ Operator's Manual iii 

Contact Us 

United States 

DCI Headquarters 

19625 62nd Ave S, Suite B103 

Kent, Washington 98032, USA 

+1.425.251.0559 / 1.800.288.3610 

+1.425.251.0702 fax 

dci@digital-control.com 

Australia 2/9 Frinton Street 

Southport QLD 4215 

+61.7.5531.4283 

+61.7.5531.2617 fax 

dci.australia@digital-control.com 

China 368 Xingle Road 

Huacao Town 

Minhang District 

Shanghai 201107, P.R.C. 

+86.21.6432.5186 

+86.21.6432.5187 fax 

dci.china@digital-control.com 

Europe Brueckenstraße 2 

97828 Marktheidenfeld 

Germany 

+49.9391.810.6100 

+49.9391.810.6109 fax 

dci.europe@digital-control.com 

India DTJ 1023, 10th Floor 

DLF Tower A, DA District Center 

Jasola, New Delhi 110044 

+91.11.4507.0444 

+91.11.4507.0440 fax 

dci.india@digital-control.com 

Russia Molodogvardeyskaya Street, 4 

Building 1, Office 5 

Moscow, Russia 121467 

+7.499.281.8177 

+7.499.281.8166 fax 

dci.russia@digital-control.com 
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Dear Customer, 

Thank you for choosing a DigiTrak locating system. We are extremely proud of the equipment 
we have been designing and building in Washington State since 1990. We believe in 
providing a unique, high-quality product and standing behind it with superior customer service 
and training. 

Please take the time to read this entire manual, especially the section on safety. Please also 
register your equipment online at access.DigiTrak.com. Or, fill in the product registration card 
provided with this equipment and either fax it to us at 253-395-2800 or mail it to DCI 
headquarters. 

Product registration entitles you to free telephone support (in the USA and Canada), 
notification of product and instruction manual updates, and helps us provide you with future 
product upgrade information. 

Feel free to contact us if you have any problems or questions. Our Customer Service 
department is available 24 hours a day, 7 days a week. International contact information is 
available on our website. 

As the horizontal directional drilling industry grows, we’re keeping our eye on the future to 
develop equipment that will make your job faster and easier. Visit us online any time to see 
what we’re up to. 

We welcome your questions, comments, and ideas. 

Digital Control Incorporated 
Kent, Washington 
2015 

 

Watch our DigiTrak Training Videos at www.youtube.com/dcikent 

 

file://///DCI-FS01/Shared%20Documents/Document%20Library/_In%20Dev/403-3300%20F5%20DataLog-LWD%20OM/English/access.DigiTrak.com
http://www.youtube.com/dcikent
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Important Safety Instructions 

Always operate your DigiTrak locating system properly to obtain accurate depth, pitch, roll, 
and locate points. If you have any questions about the operation of the system, please 
contact DCI Customer Service for assistance. 

This manual is a companion to your locating system operator's manual, which contains a 
more thorough list of warnings regarding the potential for serious injury and death, work 
slowdowns, property damage, and other hazards and warnings regarding the operation of 
horizontal drilling equipment. Please read and understand your system operator's manual 
completely before operating the equipment described in this manual. 
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Introduction 

      

Drill and Pressure Data in DataLog; F5 and Eclipse Receivers 

The DigiTrak DataLog System lets you collect and store drill data on an F5 or Eclipse 
receiver and then upload it to a computer for storage and analysis using DCI’s Log-While 
Drilling (LWD™) software. The DataLog system can measure and record the following types 
of data:  

 Depth  

 Pitch 

 Elevation change (surface topography) 

 Fluid pressure (requires an F5 fluid pressure transmitter) 

 Pullback force and fluid pressure (requires a TensiTrak transmitter) 

 Transmitter heading information (requires an SST steering transmitter) 

This manual covers the DataLog function primarily on an F5 receiver; while some instructions 
for the Eclipse system are included, Eclipse users must also refer to the DigiTrak Eclipse 
DataLog Mapping System Operator’s Manual available on DCI's website. 

As mentioned above, the DataLog system works with TensiTrak and SST transmitters. For 
complete information on the TensiTrak transmitter and SST steering system, please consult 
the respective operator’s manual, available at www.DigiTrak.com. 

The terms and techniques used in this manual are considered basic to the DigiTrak F5 and 
Eclipse locating system. You must read and understand your system operator’s manual and 
familiarize yourself with the various DataLog menus on your receiver before using the system 
for a production drill. If you have questions, please call DCI Customer Service for assistance. 

Setting Time and Calendar 

The correct time and date must be set on your F5 receiver before logging data. The option to 
set the time and calendar is available on the Settings option on the Main menu. For additional 
help on setting the time and date for your receiver, consult your operator’s manual. 

http://www.digitrak.com/customerservice/downloads
http://www.digitrak.com/customerservice/downloads
http://www.digitrak.com/
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System Components 

The DigiTrak DataLog system has four main components: 

F5 or Eclipse A receiver (locator) with DataLog menus used to display and 
Receiver  record transmitter data. 

F5, F Series, or  A battery- or cable-powered device located in the drill head with 
Eclipse Transmitter sensors that continuously measure and transmit information 

about the below-ground drill head or product pullback force. This 
information is displayed on the F5 receiver. 

LWD Software The computer application used for downloading and working with 
DataLog drill data from a receiver 

Upload Adapter A USB device required for the computer to download data from 
an F5 receiver, or an infrared serial cable device required to 
download data from an Eclipse receiver. 

Receiver 

The receiver tracks the position and depth of the transmitter and records drill and pullback 
data. The F5 receiver can record and store 50 jobs (runs) per type of DataLog file (drill or 
pressure-tension data) before some or all jobs must be deleted or uploaded to a computer to 
create room for new jobs. Each drill data job can have hundreds of data points. The number 
of data points that can be saved on each pressure-tension DataLog job is dependent only on 
the amount of memory available on the F5 receiver. 

Eclipse: This manual gives instructions for using the DataLog functions on an F5 receiver; if 
you are using an Eclipse receiver, refer to the DigiTrak Eclipse DataLog Mapping System 
Operator’s Manual available on our website. 

Transmitter 

The DataLog function will record transmitter data from all F5, F Series, and Eclipse battery-
operated and cabled transmitters. This includes the F5 TensiTrak, which provides both fluid 
pressure and product pullback force readings, and the SST steering tool, which provides 
wireline heading guidance without a grid. 

Standard drill data provided by a transmitter includes depth and pitch. A fluid pressure 
transmitter (FPT) will also provide average, high, and maximum fluid pressure readings per 
rod. To obtain a log including both drill and pressure data, you must record both a drill data 
job and a pressure-tension (P-T) data job at the same time, as depth and pitch are not 
recorded in a pressure-tension data file. 

The transmitter and receiver must be compatible to record data. The F5 receiver is 
compatible with both F5 and F Series transmitters (regional compatibility requirements apply). 
The Eclipse receiver is compatible with Eclipse transmitters only. 

http://www.digitrak.com/customerservice/downloads.html
http://www.digitrak.com/customerservice/downloads.html
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LWD Software 

The Log-While-Drilling (LWD™) software is provided on a USB flash drive that also contains 
this operator’s manual, the system operator’s manual, sample drill data, and Bluetooth 
drivers. 

 

LWD USB Flash Drive 

The software requires a computer with the following minimum specifications: 

 Microsoft Windows XP, Microsoft Windows Vista, Microsoft Windows 7, or Microsoft 
Windows 8 operating system 

 USB port 

 pointing device (mouse) 

 printer (optional) 

Bluetooth USB Adapter 

The Bluetooth USB adapter (Amp’ed RF Model BT-210) plugs into your computer to allow 
the receiver to upload data. Drivers for the Bluetooth adapter are provided on the LWD flash 
drive and must be loaded before use; see Installing LWD Software on page 23. 

 

 

Bluetooth USB Adapter 

For Eclipse: An ACTiSYS infrared (IR) cable is required to upload data from an Eclipse 
receiver. Place the IR reader over the receiver’s IR port and connect the serial plug to the 
computer. 

If your computer does not have a serial port, use the serial-to-USB adapter provided with the 
IR cable. The "Prolific" driver required for this adapter is included on the flash drive. 
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Understanding DataLog 

The as-built report you view in the Log-While-Drilling program is dependent on what you 
record on your receiver. The following sections describe the five types of reports DataLog can 
generate in Log-While-Drilling. 

Your receiver records most transmitter data using a Drill DataLog job. Fluid pressure and 
TensiTrak pullback force are recorded separately in a Pressure-Tension DataLog job. To 
view both sets of data on one graph, both recordings must be made concurrently. 

 

Note The DataLog feature must be enabled before a job can be started, stopped, 

or appended to. From the Main menu, select Drill DataLog  and/or 

Pressure-Tension DataLog , select the red Disabled…  icon so it 

turns green  (enabled), and select Exit  to return to the Main 
menu. 

Standard Transmitter Data 

To record standard transmitter data like rod number, depth, and pitch, start a Drill DataLog 
job (see Recording Data on page 10). This data will appear like this in the Log-While-Drilling 
(LWD) program: 

 

Drill Data Only 

Menu bar 

Site 

information 

Job 

information 

Toolbar 

Chart area 

Status bar 

Data points list 
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Standard Transmitter Data with Fluid Pressure 

Select an FPT transmitter in the transmitter selection screen. When you access the Locate 
screen, the receiver will automatically prompt to start a P-T DataLog job. After you start the 
P-T job and return to the Locate screen, hold the trigger briefly and toggle right to begin a 
concurrent Drill DataLog job (see Recording Data on page 10). 

 

Drill Data with Fluid Pressure 

Fluid Pressure Data Without Drill Data 

To record fluid pressure only, start a Pressure-Tension DataLog job as discussed in the 
previous section but do not begin a concurrent Drill DataLog job. Because no drill rod data 
exists for the pressure data to be paired with, the resulting LWD graph will show raw, time-
based fluid pressure data only. 

 

Fluid Pressure Only 

 

Depth 

Fluid pressure 
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TensiTrak Pullback Force and Fluid Pressure Data 

To record fluid pressure and pullback force while using a TensiTrak pullback transmitter, 
start a P-T DataLog job. Because a pilot bore transmitter is not installed during product 
pullback, TensiTrak graphs have the same jagged appearance as a fluid pressure job without 
drill data. 

 

TensiTrak Pullback Force and Fluid Pressure without Drill Data 

For a complete discussion of how to use and record data for a TensiTrak transmitter, please 
refer to the TensiTrak Operator's Manual available at www.DigiTrak.com.  

Pressure 

Force 

http://www.digitrak.com/
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Steering Tool (SST) Data 

Recording elevation, bore path profile, and left/right deviation with an SST Steering Tool 
transmitter does not use the DataLog feature. Instead, it requires running the LWD software 
live on a laptop connected to the drill rig while drilling. 

 

LWD Steering Tool (SST) Elevation and Course Data  

For a complete discussion of how to use and record data for an SST transmitter, please refer 
to the SST Operator's Manual available at www.DigiTrak.com. 

Two-dimensional 

view of bore 

Left/right deviation 

(bird's-eye view) 

http://www.digitrak.com/


DIGITAL  CONTROL  INCORPORATED 

8 DigiTrak DataLog/LWD™ Operator's Manual 

Receiver DataLog Menus 

From the F5 receiver’s Main menu, toggle down twice to display the Drill DataLog  and 

Pressure-Tension (P-T) DataLog  menu options. 

 

F5 Receiver Main Menu, Second Screen 

Drill DataLog Menu 

Use the Drill DataLog menu  to record pilot hole drill data.  

 

Drill DataLog Menu  

Drill DataLog 

Pressure-Tension (P-T) 

DataLog 

Description of 

highlighted option 

Delete DataLog job(s) 

Add survey point 

View DataLog jobs 

Set up Drill DataLog job 

Upload Drill DataLog job 

to a computer 

Enable/disable Drill 
DataLog function 
(green if enabled, 

red if disabled) 
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Pressure-Tension (P-T) DataLog Menu 

Use the Pressure-Tension (P-T) DataLog menu  to record fluid pressure. When you 
access the Locate screen, the receiver will automatically prompt to start a P-T DataLog job. 

 

Pressure-Tension (P-T) DataLog Menu 

A Drill DataLog job records all transmitter data other than fluid pressure. A P-T DataLog job 
records pressure and TensiTrak pullback force. To see Drill and P-T data on one report, both 
jobs must be recorded at the same time for one bore. When you upload a Drill DataLog that 
was recorded concurrently with a P-T DataLog, the LWD software automatically includes the 
P-T data with the Drill data. 

Enable/disable P-T DataLog 
function (green if enabled,  

red if disabled) 

Exit 

Upload P-T DataLog job to 
a computer 

 

Delete P-T DataLog job(s) 

The “p” indicates a fluid 

pressure transmitter is selected 
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Recording Data  

To record pilot bore drill data, the receiver must be receiving data from a properly calibrated 
transmitter, as described in your receiver operator’s manual. 

Ensure the Drill DataLog and Pressure-Tension DataLog features are enabled as described 
in the note on page 4. 

Creating a New Job 

 

Note To include pressure/tension data with your Drill DataLog, select an FPT 
transmitter in the transmitter selection screen and return to the Locate 
screen, where the receiver will automatically prompt to start a P-T DataLog 
job (see Recording P-T Data on page 21). When you return to the Locate 
screen, continue below to begin a concurrent Drill DataLog job. 

1. At the Locate screen, hold the trigger briefly and then also toggle right to display the 
Drill DataLog Start Recording menu.  

2. Select Create a New Job . 

 

Drill DataLog Start Recording Menu 

Create a new job 
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3. Enter the drill rod (pipe) length to be used for this bore on the keypad, then select 

Enter  to set it as the drill rod length. 

 

Keypad for Entering Pipe Length (Rod Length) 

Ten feet (3.05 m) is the default rod length. The receiver remembers your last rod 
length. 

4. The 1st rod length input screen appears with a default value. This length is 
automatically calculated as 70% of your pipe length. If this is correct for your bore, 

select  to set this value and skip to step 5. 

 

1st Rod Length Input Screen 

 

Note If the drill head cannot be positioned so the slots are half above and half 
below the ground due to tooling configuration (as shown in the preceding 
and following illustrations), you can still illustrate this later in LWD on your 
uploaded bore data by opening Job Information (under the Edit menu) 
and entering a value in the Rel. Elev. (Relative Elevation) At Entry box. 
For example, if the housing slots are four ft. below ground, enter a value of -
4. See Survey Point Elevation Change on page 31 for more information on 
this topic in the Log-While-Drilling software. 

Enter 

Set 1st rod length  

to default value  

Select keypad to 
enter different value 

1st rod length 



DIGITAL  CONTROL  INCORPORATED 

12 DigiTrak DataLog/LWD™ Operator's Manual 

To calculate a different 1st rod length value, measure from the make-up/break-out 
clamps to the top of the rod when the drill head is positioned for the first data point. For 
this measurement, the housing slots should be half above and half below the ground 
(or a plane parallel to the ground if drilling into a pit). The elevation at the first data 
point is the Zero Reference elevation, and is generally at the surface of the ground. 

Select the keypad, enter the desired value, and select Enter . 

 

 

Measuring the 1st Rod Length 

5. When recording the first data point (rod 0), the only available option will be Record 

Pitch Only . With the receiver positioned within range of the transmitter (it does not 

have to be at the locate line or front locate point), select  to record the data point. 

 

Drill DataLog Recording Options (Pitch Only) 

The receiver beeps twice and returns to the Locate screen. 

6. Advance the drill head to the end of the first rod and position the receiver over the 
locate line (LL) or the front locate point (FLP). 

Top of rod 

Slots in housing 

1
st
 rod length 

Make-up/break-out clamps 

Drill carriage 

Zero elevation 

reference line  

Surface of 

ground 

Record pitch only 
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7. Hold the trigger and toggle right once to display the Drill DataLog Recording Options 
menu, which now has all options enabled. 

  

Drill DataLog Recording Options  

8. Select one of the following: 

 Record depth/pitch  to log the depth and pitch information. 

 Record pitch only  to log only the pitch because you are unable to position 
the receiver at the LL or FLP. This is also useful when drilling under rebar which 
may decrease signal strength that can result in incorrect topography values in the 
graph. 

 Record a blank rod  if you have no data because you cannot position the 
receiver within range of the transmitter. 

Click the trigger to record the second data point (rod 1). The receiver will beep several 
times and return to the Locate screen. 

9. Continue drilling, using the trigger/toggle right sequence to record data points at the 
end of each drilled rod. 

Record depth/pitch Record a blank rod 

Record pitch only 
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Recording Partial Rods 

The DigiTrak Log-While-Drilling (LWD) computer software requires data points to be recorded 
at equally spaced intervals, such as at the end of each drill rod. However, when drilling with 
long drill rods and/or making significant pitch changes, you may want to record data at partial 
pipe length intervals to more accurately depict the bore profile and changes in topography. 
The LWD function can accommodate quarter, half, three-quarter, and full pipe lengths. Partial 
rods may only be recorded after rod 1 (second data point) has been recorded. 

To record a partial rod: 

1. Position the receiver at the FLP or over the head at the LL, if possible. 

2. At the Locate screen, hold the trigger and toggle right once to view the Recording 
Options screen. 

  

Drill DataLog Recording Options (First Screen) 

3. Toggle down and select Data at Partial Rod  on the second page. 

  

Drill DataLog Recording Options (Second Screen) 

Record depth/pitch Record a blank rod 

Record pitch only 

Data at Partial Rod 

View/delete rod data 

Rod length (full, 1/4, 1/2, 
3/4, or finish depending 

on whether a full or 

partial rod is selected) 
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4. Select a partial rod length.  

 

DataLog Partial Rod Screen 

The display returns to the first recording options screen but the partial rod value (¼, ½, 
¾, or finish rod) appears in place of “Full Rod” for the rod length (see image in step 2). 

5. Select the option to record depth and pitch (or pitch only if you are not able to position 
the receiver at the LL or FLP) and click the trigger to record the data point. The receiver 
beeps several times and returns to the Locate screen. 

6. Record another data point at the partial rod length or end of the rod. 

The “Finish Rod” option appears if a partial rod was previously recorded. 

Closing or Pausing a Job 

Both drill and P-T jobs must be closed before they can be uploaded. Close a Drill DataLog 
job after recording the last data point and documenting the last rod.  

You can also pause a DataLog job so it remains open while you navigate menu options. All 
DataLog jobs close automatically when the receiver powers off. 

1. At the Locate screen, toggle down to open the DataLog Close/Pause Recording menu. 
 
If both Drill and DataLog data are being recorded, the Drill DataLog Close/Pause 
Recording menu will display first (shown below), followed by the P-T Close/Pause 
Recording menu. 

2. Select Close Job  to close the DataLog job. The job can now be uploaded to a 
computer (see Uploading Data to a Computer on page 23) or added to later (see 
Appending to an Existing Job on page 16). 
 
-OR- 

Select Pause Job  to keep the job open. When you return to the Locate screen: 

 Drill DataLog: your next data point will record on the same job 

 P-T DataLog: data will continue recording automatically 
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Drill DataLog Close/Pause Recording Menu (same options as P-T) 

To include landmark or utilities information with your drilling data, handwrite the depth, 
description, rod number, and/or distance from the entry for each item. Add this information to 
the drill data later using the LWD software on your computer. 

 

Note An F5 receiver can store a total of 50 Drill and 50 P-T jobs. The 
receiver displays a warning at 45 saved jobs. Trying to save more than 
50 jobs will return you to the Start Recording menu where you can 
append to a job or exit. 

Appending to an Existing Job 

Use Append in the Start Recording menu to add data to a DataLog job that has been closed 
or paused. 

When the P-T DataLog function is enabled and a pressure sensing transmitter is in use, the 
P-T Start Recording menu displays whenever the Locate screen is accessed. This menu lets 
you create (start recording) or append to an existing job. This menu is the same for the Drill 
DataLog function. 

Pause job Close job 
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1. At the Locate screen, hold the trigger and toggle to the right once. 

2. Select Append… . 

  

Drill DataLog Start Recording Menu (same options as for P-T) 

3. Select the job number to append to. 

     

Sample DataLog Jobs Lists 

4. Drill DataLog only: On the Drill DataLog recording options screen, select the 
appropriate option to continue logging data points. 

5. Continue recording drill rods or partial rods as described earlier in this section.  
 
P-T data continues recording automatically. 

Append to an existing job 

“L” displays for Drill 
DataLog jobs; “PT” 

indicates a pressure-

tension DataLog job 
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Viewing and Deleting Rods from the Receiver 

1. At the Locate screen, hold the trigger and toggle right once to view the Recording 
Options screen. 

2. Toggle down and select View/Delete Rod Data . 

  

Drill DataLog Recording Options (View/Delete Rod Data) 

3. In the View Rod Data List, the most recent rod data (the only one that can be deleted) 
is highlighted in the top row. Click to select it (to return to the Locate screen without 
deleting the data point, simply toggle left or right). 

  

View Rod Data List 

View/delete rod data 

Data for most 

recent rod 

Survey point (appears 
blank unless value is 
entered under Survey 

Point menu option) 
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4. Click  to delete the last rod data point, or Exit  to cancel and return to the 
Locate screen. 

  

Delete Rod Screen 

5. Continue these steps for each rod you need to delete, selecting the most recent data 

point from the list shown in step 3 and then  to delete. When you are finished 
deleting rods, toggle left or right in the View Rod Data List to return to the Locate 
screen. Visually confirm that the number of rods used matches the View Rod Data list. 

Measuring and Documenting the Last Rod (Optional) 

When the drill head exits the ground, measure and document the length of the last rod, as it 
does not get recorded with the drill data in the receiver. Enter this value manually in the LWD 
software after the job is uploaded. 

The last rod measurement is the pipe length minus the length of drill rod left on the rack. For 
example, if the pipe length is 10 ft. and 6 ft. remain from the make-up/break-out clamps to the 
top of the rod, the last rod measurement will be 10 – 6 = 4 ft. 

 

Last Rod Measurement 

Make-up/break-out clamps 

Drill rods 

Slots in 

housing 

6 ft. rod length left on rack 
Ground surface 

(topography) 

Zero elevation 

reference line 

Drill  
head 

Termination/ 

end point 

Pipe length  

10 ft. 

Drill 

Top of rod 

Delete most recent 
rod data point Exit 
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Adding a Drill DataLog Survey Point 

If there is a difference in elevation between the entry and exit of the bore, consider adding a 
survey point to correct for any accumulated pitch variance that may affect the profile graph. 
This provides a more accurate graph of the bore and terrain in the LWD software. 

From the Main menu, select Drill DataLog, then Add survey point. The survey point can 
also be entered later in the Log-While-Drilling software after data upload (see Survey Point 
Elevation Change on page 31). 

1. In the Drill DataLog menu , select Add survey point . 

2. From the list of existing drill jobs displayed, select the job to add the survey point to. 

3. Select the keypad. 

  

Survey Point Menu 

4. Use the onscreen keypad to enter the surveyed value for the difference in elevation 
between the entry and exit of the bore. 

This keypad includes a “+/-” button, since the elevation difference can be positive or 
negative. The keypad assumes the value will be positive, meaning the exit has a higher 
elevation than the entry. Use the +/- button to change as needed. 

5. Select Enter  to set the displayed value as the survey point value. The screen 
returns to the DataLog menu. 

 

Note A survey point can be added to the job later in the Log-While-Drilling 
software. See Survey Point Elevation Change on page 31.  

Set survey point back to 
unknown (the LWD 

software will calculate the 

elevation difference) 

Open keypad to 
enter known 

elevation difference 
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Recording P-T Data 

Select an FPT transmitter in the receiver transmitter selection screen and when you access 
the Locate screen, the receiver will automatically prompt to create a Pressure-Tension (P-T) 
DataLog job. 

Recording with Drill Data 

1. At the P-T DataLog Start Recording menu, select Create a new job . The new job 
number displays at the bottom of the screen. 

  

P-T DataLog Start Recording Menu 

The receiver returns to the Locate screen and P-T data begins recording, as indicated by the 
recording icon next to the roll indicator. 

  

P-T Data Recording Icon 

At the Locate screen, hold the trigger briefly and then also toggle right to begin a concurrent 
Drill DataLog job (see Recording Data on page 10). 

Create a new job (opens 
Locate screen; data will 
be recorded under indi-
cated job number) 
 

Exit (returns to locate  
mode screen; no data is 
recorded) 
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Recording Without Drill Data 

To record Pressure-Tension data only, start a P-T DataLog job as described in the previous 
section but do not begin a concurrent Drill DataLog job when you return to the Locate screen. 

Because no drill rod data will be recorded, the resulting LWD graph will show raw, time-based 
fluid pressure data only. 

Setting Data Flags 

Only use data flags with TensiTrak, or when recording fluid pressure without a concurrent 
Drill DataLog. Data flags help match data points to a specific point along the bore path. 

The Flag Recording menu is available only when a P-T job is already running and the 
receiver is at the Locate screen. DCI recommends that you record flags at significant points 
along the bore path, such as before and after crossing under a roadway or stream, to help 
correlate physical locations along the drill/pullback path with the P-T file data points. 

1. At the Locate screen, toggle right to display the Flag Recording menu. 

  

DataLog Flag Recording Menu 

2. Select Set a flag  to record a flag. Once a flag is recorded, it cannot be deleted 
from the P-T data file. 

3. Keep notes of flag numbers and details of the location where each flag was recorded, 
such as “entering under road” or “far edge of streambed”. Add this information to the 
P-T data file after it is uploaded to your computer. 

Set a flag (records flag 
number indicated on 

Locate screen) 

Exit (returns to Locate 
screen without recording 
a new flag)  
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Installing LWD Software  

Minimum system requirements for use of LWD software on a computer can be found on 
page 3. 

The default location for the LWD program files is c:\Program Files\DCI\DigiTrakLWD. LWD 
data files and sample data files will be placed in My Documents\DCI. You can change both of 
these default locations during installation. 

1. Close any open applications.   

2. Insert the LWD flash drive into a USB port and view the contents of the drive. 

3. Open the LWD Kit folder and double-click Drivers for LWD to install drivers. 

4. Open the Bluetooth Driver folder and double-click the *.exe file to install Bluetooth 
drivers (if you don’t see file extensions like .exe, double-click the file of type 
Application). 

5. Open the DigiTrak LWD Software folder and double-click on the setup file (setup.exe) 
to install the LWD software. 

After these drivers and software have been installed, the LWD shortcut icon  appears on 
your desktop. 

Uploading Data to a Computer 

Uploading DataLog jobs from the F5 receiver to your computer involves adding the F5 
receiver to the LWD software’s Bluetooth device list and then uploading the files to the 
computer over the Bluetooth connection.  

For Eclipse: Skip to Uploading Data from an Eclipse Receiver on page 25. 

Add F5 Receiver to LWD Bluetooth Device List 

An F5 receiver must be added to the Bluetooth device list in the LWD software prior to first 
use. 

1. Power on your computer and insert the Bluetooth USB adapter (Amp’ed RF Model 
BT-210) into a USB port. 

2. Power on the F5 receiver and select System Info  from the Main menu. 
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3. Keep this screen open, or write down the receiver ID number and the Bluetooth device 
address. 

  

Receiver System Information Screen 

4. Open LWD by double-clicking the LWD icon  on your desktop. 

5. Click Bluetooth  (menus View > Bluetooth Device List) to open the Bluetooth 
Device List dialog box. 

6. Enter your Bluetooth Device Address in the specified field. 

  

Bluetooth Device List Dialog Box 

7. In the Bluetooth Device Name field, enter your receiver ID number. 

8. Click Add. 

9. Click OK. The device appears in the Bluetooth device list. 

You are now ready to upload job data. 

Bluetooth device 

address Receiver ID number 
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Uploading Data from an F5 Receiver  

DCI recommends uploading data to a computer following every DataLog job. 

1. Open the DataLog menu for the type of job file you are uploading: drill data  or 

pressure-tension . 

2. Select Upload job . 

3. Select the job to upload. 

 

Note Data must be communicated to the computer within 15 minutes or the 
receiver will power off due to inactivity. 

4. Open LWD by double-clicking the LWD icon  on your desktop. 

5. Click New  (menus File > New). 

6. Select the type of file to upload (drill data or pressure-tension) and click OK. 

7. On the blank form that displays, click Connection  (menus File > Upload Control). 

8. On the Upload Control dialog box, select Bluetooth. 

9. In the Serial Port Connection drop-down list, select Silicon Labs CP210x USB to 
UART Bridge (COM#). 

10. Select your receiver’s name from the Bluetooth drop-down list. 

11. Click the Connect to Device button to begin uploading. 

12. After the data has been transferred, the DataLog Job Information dialog box will 
appear. You may enter the requested details now or later. 

13. Click OK. 

The new job data displays in the information fields and chart areas in the LWD application 
window. 

Uploading Data from an Eclipse Receiver 

Upload data from an Eclipse receiver requires the ACTiSYS IR cable provided with the 
Eclipse DataLog system and, if you do not have a serial port on your computer, the USB-to-
serial adapter. 

1. Plug the ACTiSYS IR cable into the serial (COM) port on your computer (or USB port, if 
using the USB-to-serial adapter). 

2. Power on the computer and receiver. 

3. Open LWD by double-clicking the LWD icon  on your desktop. 

4. Click New  (menus File > New). 

5. Select the type of file to upload (drill data or pressure-tension) and click OK. 

6. On the blank form that displays, click Connection  (menus File > Upload Control). 
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7. On the Upload Control dialog box, select Infra-Red. 

8. In the Serial Port Connection drop-down list, select the communication (COM) port 
assigned to the IR cable. 

9. From the Main menu, toggle right and select DataLog. 

10. Select Send Data. 

11. The receiver displays the last job logged. Select the correct job to upload. 

12. Align the IR reader on the end of the cable with the red IR port on the left side of the 
receiver’s display window, then click the trigger to begin uploading. 

The drill data will appear immediately on the computer screen if the upload is successful. 

Uploading Recommendations 

DCI recommends that you upload data for each run twice, saving each with a different name. 
This ensures that no matter how many changes you make to the file in LWD, you will still 
have an original backup to refer to. 

If you recorded a data point using the pitch-only or blank rod option, that data point will 
appear to be missing data. The LWD software will make assumptions to fill in the missing 
data or you can enter your own data. 

Deleting a DataLog Job 

1. In the Drill DataLog menu , select Delete DataLog job . 

2. Select the button to delete one  or all  jobs. 

   

Delete DataLog Jobs Menu 

3. If deleting one job, select from the list of available Drill and P-T DataLog jobs. 

Delete one job 

Delete all jobs 
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4. At the confirmation screen, select Confirm  to delete or Exit  to cancel. 

 

 Confirm Job Deletion Screen 

A deleted job cannot be recovered. Ensure you have uploaded jobs you want to save to a 
computer before deleting them from the receiver. 

 

Exit without 

deleting job Confirm job deletion 
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Using LWD 

Starting LWD Program and Opening Files 

Start the Log-While-Drilling (LWD™) program by double-clicking the LWD icon  on the 

desktop. Click New  (menus File > New) to start a new DataLog job file and select the 
type of job file to start: drill data, pressure-tension, or steering. 

A new drill data form will be blank; an LWD form with data will look like this: 

 

LWD Drill Data Window 

Click Open  (menus File > Open) to open an existing DataLog file. You can also open a 
DataLog file directly from Windows Explorer by double-clicking a *.dl5 Drill DataLog or *.tt5 
pressure-tension file. 

The LWD Help menus are an excellent source of in-program information. Detailed information 

on reading and editing the data fields are provided in the Help  files. With the Tooltip 

Helper , click on a screen element for help with that function.  

Many of the LWD menu commands are similar to those used in other Windows programs, 
and some have associated icons on the toolbar. Point the cursor at any icon in LWD for a 
tooltip describing its function. Icons or menu items that are grayed out do not pertain to the 
current DataLog file type. See Appendix B – Menu on page 48 for a complete list of menu 

options and their corresponding menu bar buttons. For example, click Display Units  
(menus Edit > Display Units) to change units of measurement between decimal feet (ft.) or 
meters (m). 

Menu bar 

Site 

Information 

Job 

Information 

Toolbar 

Chart Area 

Status bar 

Data Points List 
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Components of an LWD Screen 

Site Information  

Click Site Information , or in the menus select Edit > Site Information, or double-click 
in the Site Information area shown below to edit this information. 

   

Site Information on Screen (left) and Dialog Box 

All the address and contact information for the job, client, and contractor are listed on the 
printed report (see Saving, Printing, and Sending Your LWD Job on page 44 for more 
information). 

 

Note Site information remains from job to job to reduce the need for 
reentering identical data. If this information doesn't save from job to 
job, particularly for versions after Windows XP, try this: exit LWD, 
right-click the desktop LWD icon, select Properties, select the 
Compatibility tab, check the box for "Run this program as an 
administrator", and click OK. 
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Job Information 

Click Job Information , or in the menus select Edit > Job Information, or double-click in 
the Job Information area shown below to edit this information. 

   

Job Information on Screen (left) and Dialog Box 

The Job Information section displays statistical information about the job. Some fields may 
not be changed. 

Date For an F5 receiver, the date corresponds to the first uploaded 
data point; for an Eclipse receiver, it’s when the job was 
uploaded; for imported Eclipse files, it’s the date the file was 
imported into the LWD application. 

Serial Number ID or serial number of the receiver 

Job ID Number assigned to the job in the receiver 

Data Points Number of data points collected (includes manually inserted 
data) 

Typical/Default Rod 
Length Length of the rods in use. 

Depth Measurement units being used for depth, feet (ft.) or meters (m) 

Pitch Measurement units being used for pitch, percent (%) or degrees 
(°) 

Pressure Measurement used for pressure, pounds per square inch (psi) or 
kilo-Pascals (kPa) (not shown above) 

Entry Entry position relative to the (0, 0) coordinates on the charts 
(positive or negative distance on the profile view chart and left 
(L) or right (R) position on the plan view chart) 
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Rod Length Information 

Typical/Default Rod 
Length Rod length data is included in F5 receiver uploads, but can be 

changed here if it was entered incorrectly on the receiver.
1
 

First Rod Length The rod length for the first data point (rod 0), which is usually a 
partial rod. This value is determined by measuring the amount of 
drill rod left in the rack from the make-up/break-out clamps to the 
top of the rod when rod 0 is recorded. 

Last Rod Length The rod length for the last data point, which is usually a partial 
rod. This value is determined by measuring the length of the drill 
rod left on the rack from the make-up/break-out clamps to the top 
of the rod and then subtracting this distance from the rod length. 
For example, if the length of rod left on the rack is 6 ft. 1.8 m, 
and your rod length is 10 ft., the last rod will measure 4 ft. 
(10 ft.  – 6 ft.). 

Survey Point Elevation Change  

Do Not Use Reference  
Elevation Select if the entry and exit are at the same elevation. Clearing 

this check box enables the Reference Elevation field below it. 

Reference Elevation The elevation of a reference geographical survey point near the 
bore. If a reference elevation is not required, select the Do Not 
Use Reference Elevation box to disable this field. The terrain 
surface at the drill head's entry will be the zero elevation 
reference on the chart and the data points list. When a reference 
elevation is used, its value becomes the zero reference on the 
chart and the data points list. 

Relative Elevation at Entry The vertical distance from the zero elevation reference line to the 
point where the bore penetrates the ground. In most cases, the 
entry is at the terrain surface. When using an entry pit, this point 
is at the bottom of the pit. 

Do Not Use Exit Survey  
Point Select this box if there is no elevation difference between the 

entry and exit. The exit will then be calculated based on the 
pitch, rod, and depth data only. 

Rel. Elev. at Exit The positive or negative difference between the entry and exit 
elevations. Enter a negative value if the exit is lower than the 
launch; do not use a + symbol for a positive value. This 
information can be captured on the F5 receiver by setting a 
Survey Point. 

 

                                                      

1
 For Eclipse receiver uploads, set the default rod lengths by clicking the Set Defaults button. This setting will then 

be used for all new Eclipse uploads. Changes made to the settings of an individual file will stay with the saved file. 
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Note If using an entry pit, include the depth of the pit in the value for Rel. 
Elev. At Entry. Rod 0 must be edited to show the depth of the pit 
below the reference elevation. If a reference elevation is not used, edit 
rod 0 to show the depth of the pit as the relative elevation at entry. 

Data Points List 

The data points list is a table displaying all data points in the job. Within this table you can 
insert, edit, delete, hide, or remove individual data points. The columns included in the table 
depend on the type of DataLog file open. See Components of an LWD Screen on page 29 
and Pressure-Tension DataLog Features on page 39 for more information. 

Chart Area 

The chart area provides a graphical display of the data contained in the data points list. 
Hidden or deleted data points will not display in the chart area. The type of data displayed 
depends on the DataLog file type and the data recorded. Drill data files show a profile chart 
and, if an FPT is used, a pressure chart; pressure-tension files show a pressure chart and, if 
a TensiTrak transmitter is used, a force chart; steering files (not addressed in this manual) 
include profile and plan view charts. 

The common features of chart areas include: 

Data Points Data points that have not been hidden or deleted 

Values Value of the points contained in the chart area 

Cursor Coordinates Place the cursor anywhere on the chart area to see the value of 
the coordinates at that point. Place the cursor on a data point to 
display data values recorded at that point. 

Zoom Hold the Control key and drag the pointer through an area to 
zoom in. To return to normal scaling, Control+click anywhere in 
the chart area. 
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Editing and Annotating Charts 

Profile, pressure, and force charts can be edited and annotated in a number of ways. For 
example, under the Edit menu, use the Annotations commands to draw shapes and captions 
directly on charts to describe job site conditions and other points of interest, or use the 
Properties commands to change boundaries of charts.  

Drawing Shapes and Adding Captions 

To draw shapes and enter information to be included on the chart and the printed report, hold 
the Shift key and draw a box where you would like a shape to appear on the chart. This 
opens an annotations dialog box that includes the Location coordinates of the box. 

  

Annotations Dialog Box 

Alternatively, click Profile , Pressure , or Force Chart Annotations  (all also in 
the Edit menu) and enter Location coordinates manually. 

Double-click an existing annotation to change its properties (captions cannot be edited in this 
manner, only objects). 

Select a Shape to add from the drop-down box. Adjust the Line Weight and Font Height as 
needed. Use the check boxes and double-click the ellipses in the Draw Shape section to set 
shape properties and colors. 

Select the Draw Caption check box to activate the Caption section. A caption does not 
require a shape. Captions appear centered in the shape by default. To change the location or 
orientation of caption, use the Top - Left and Text Slope fields. 
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Editing Chart Properties 

To edit properties such as chart boundaries and scaling, click Profile , Pressure , or 

Force Chart Properties  (all also in the Edit menu). 

 

Profile Chart Properties Dialog Box 

To enter different coordinates for chart boundaries, clear either or both of the Auto Scale 
check boxes and enter new values. 

Data Points List 

The data points list is a table displaying all data points in the job in sequential order, along 
with their associated data. Depth and pitch units are displayed in the job information box. The 
columns in the table are as follows: 

Rod ID Rod number and status of the data point. A colored flag is 
displayed to indicate the status of the data:  

 Red Flag: Pitch missing; enter pitch for the bore path to be 
calculated correctly. 

 Magenta Flag: Depth missing; highlights pitch-only data 
points for the operator. Open the Edit Data Point dialog box 
and click OK to restore this flag to either blue or green 
depending on the data entered by the operator for depth. 

 Blue Flag: Data point has been edited 

 Gray Flag: Data has been hidden or removed 

 Green Flag: Overwritten data 

 Black Flag: Original data 

Rod Len. Length of the rod 

Bore Len. Length of the bore (sum of all the previous rod lengths plus the 
current rod length) 

X Dist. Horizontal distance from the entry 

Pitch Pitch value recorded at the specified data point 
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Rel. Depth The depth of the drill head below the zero elevation line.  

Depth The distance from the drill head to the terrain surface. This can 
be measured, entered manually by the user, or interpolated by 
the LWD software based on inserted or missing data. 

Rel. Elev. The positive or negative difference from the Zero Elevation Line. 

Date/Time The date and time the specified data point was recorded. This 
information will not appear on the printed report. 

Type Information regarding the type of data recorded at the data point: 

 BL: Blank (no pitch or depth data recorded with data point)  

 PO: Pitch Only  

 LL: Locate Line  

 FLP: Front Locate Point  

 IN: Inserted data point. Pitch and depth defaults are 
interpolated from adjacent data and not displayed by default. 
This data can be modified if required by overwriting the 
default values listed. The new data point is listed 
alphabetically (such as, the first point manually inserted after 
rod number 2 is listed as 2-A, the second as 2-B, etc.). 

RawDepth The projected depth displayed on the receiver. 

RawDist The horizontal distance from where a data point was taken at 
either the FLP or the LL to point directly above the transmitter. 

Comment Any comments on individual data points can be added to show in 
this column (see Edit Rod/Data Point below). 

Drill 

Entry 

Drill Rods 
Rod Length 

Rel. Depth 
Zero Elevation Line 

Drill Head 

Terrain Surface 

(Topography) 

Depth 

Rel. Elev. 
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Symbols in the data points list identify different types of data: 

o data overwritten manually   

e rod length edited  

i data interpolated   

f data filled in; data missing in original upload   

h data hidden   

x pitch data missing   

Editing Data Points 

Right-click a data point in the table to open a pop-up menu with the options to Edit, Insert, 
Delete, Hide, and Remove. 

 

Data Point Table Shortcut Menu 

Edit Rod/Data Point 

Right-click the data point and select Edit, or simply double-click a data point in the list or on 
the chart. Edit the data or add comments as required. Click OK to save changes, or Cancel. 

  

Edit Data Point Dialog Box 

Box is automatically 
checked if blank or pitch-

only rod is inserted 

Box is automatically 
checked if blank rod is 

inserted 

Rod length in same units 

as depth measurement 
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If a blank data point exists, the Pitch is Missing/Unknown check box is selected by default. 
If you don’t enter the correct pitch value and uncheck the box, there will be a gap in the data 
line on the chart. The missing data point will be emphasized on the chart. 

If a new rod is inserted or a blank or pitch-only data point is recorded, the Depth is 
Hidden/Unknown check box is selected by default. If you don’t enter the depth value and 
uncheck the box, there will be a gap in the data line on the chart and the missing point will not 
be shown. 

To restore original recorded data, click the Restore Default button next to the data to be 
restored. 

Insert Rod/Data Point 

Right-click the data point prior to where the new data point is to be inserted and select Insert. 
A new data point appears in the data list and on the chart. 

The new data point will be numbered the same as the one prior to it with a letter appended. 
For example, the first point manually inserted after rod 2 will be listed as 2-A, the second as 
2-B, and so on. The values listed for pitch and depth are interpolated from adjacent data, and 
depth is hidden by default. The rod type will be listed as IN for inserted data. You may 
change data values as needed. To restore original interpolated data values, click Restore 
Default under the corresponding data field. 

Delete Inserted Rod/Data Point 

Right-click the data point to be deleted and select Delete. The data point is removed from the 
data points list and from the chart.  

Original data cannot be deleted. If a rod is unintentionally recorded twice, select Remove to 
remove that data point. 

For Eclipse: Eclipse receiver data is imported, considered original data, and cannot be 
deleted. 

Hide 

When this option is selected, the data point still appears in the data list but it is hidden on the 
chart. The data is still included in the calculations. A checkmark is placed next to the option 
on the pop-up menu. 

Remove 

Select this option to remove the data point from the list, chart, and calculations. Use this 
option on original data that was unintentionally recorded twice. 
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Profile Chart 

The profile chart is a visual representation of the DataLog data. 

 

Drill Data Profile Chart 

Data Points 

Data points on the profile chart display as blue dots. Hover over a data point to display data 
recorded at that point. Click a data point on the profile chart to display its corresponding row 
in the data points table. Gaps in the data points indicate missing data. 

Highlighted data points (points with gray circle behind them) indicate a rod has been inserted 
or the pitch has been edited.  

Green terrain points can only be edited for depth, after which they will also be highlighted. 

Sometimes hiding a data point on the chart is helpful to allow other elements to display, such 
as a utility flag. A data point hidden on the profile chart will still display in the data points list. 

Utility Flags 

Use utility flags to show the location and type of utilities on the chart and printed report. To 

add or edit utility flags, click Edit Utility Flags  (menus Edit > Utility Flags) to open the 
Utility Flags dialog box. Or, Shift+click a chart data point to open the dialog box with the 
location of a new flag automatically specified at that point. 

 

Utility Flags Dialog Box 
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The fields on the Utility Flags dialog box are as follows: 

Type Select from the drop-down list. The flag will appear on the chart 
as a circle using APWA (American Public Works Association) 
recommended colors. 

X Dist (Distance) The horizontal length on the surface of the ground from the entry 
to the utility 

Depth The vertical length from the surface to the utility 

Comment The default caption is the type of utility; enter a comment to 
create a new caption. 

Text Slope The angle of the caption text on the chart 

Don’t confuse Utility Flags with Data Flags in pressure-tension files, which are added by the 
receiver operator as data is recorded. 

Pressure-Tension DataLog Features 

In addition to the features described in the beginning of the previous section, Pressure-
Tension files contain information and controls specific to the logging of fluid pressure 
(provided by a pressure-sensing transmitter) and pullback force (provided by a TensiTrak 
transmitter). 

Remember: record a Drill DataLog concurrently with a P-T DataLog to refine your fluid 
pressure data with regular transmitter data and create a more typical line chart as shown on 
page 5. 

Job Information 

To add and edit job information to be included on the printed report—such as pressure or 
tension limit thresholds allowed for the job, product type installed for a TensiTrak job, and 

direction of graphed data—click Job Information  (menus Edit > Job Information) or 
double-click the Job Information box. 

  

Pressure-Tension Job Information Dialog Box 



DIGITAL  CONTROL  INCORPORATED 

40 DigiTrak DataLog/LWD™ Operator's Manual 

Design Limit Thresholds 

Allows you to enter limits for acceptable pressure and/or tension (pullback force) values 
recorded during the bore and/or product installation. The design limit thresholds displays on 
the printed report. 

Use Tension Design Limit Select to enter a value for the maximum pullback force allowed 
for the project. 

Use Pressure Design Limit Select to enter a value for the maximum fluid pressure allowed 
for the project. 

With a design limit threshold, data points in the list and chart area will be yellow or red as the 
design threshold limit is approached or exceeded. 

Product Information 

Material Details about the material installed for a TensiTrak job 

Length Total length of product installed during the product pullback 

Diam Diameter of the product installed 

Right to Left or  
Left to Right The direction the data displays on the graph area. The data 

should be displayed relative to the direction of the pilot bore 
profile chart for accurate comparison. Select Right to Left when 
product is pulled in from the pilot bore exit. Select Left to Right 
when the pressure and/or tension data is recorded starting from 
the entry of a pilot bore. 

Data Points List 

The data points list is a table displaying all data points in the job in sequential order, along 
with their associated data. Pressure and force units are displayed in the job information box. 
The columns in the table include: 

Data Point The number and status of the data point 

Force The force value recorded by the receiver at the specified data 
point. An “x” indicates no data. 

Max F. The maximum force value recorded by the receiver at all data 
points up to the one indicated. An “x” indicates no data. 

Pres. The pressure value recorded by the receiver at the specified 
data point. An “x” indicates no data. 

Max P. The maximum pressure collected during the job up to when the 
data point was recorded 

Data Flag Marked if a flag was recorded on the F5 receiver at a specified 
data point 

Date/Time The date and time the specified data point was recorded. This 
information does not display on the charts or printed report. 
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Removing Data Points 

Click on the graph where you want to remove data points. The data points list adjusts to show 
the group of data points near that location.  

 To select a range of data points in the list, click on the first data point, then Shift+click the 
last data point to include all points in between.  

 To select multiple data points that are not in a continuous range, Control+click each data 
point. 

Right-click in the selected data points and select Remove. The data points list will indicate 
the points have been removed from the chart. 

Pressure Chart  

The pressure chart shows the downhole fluid pressure recorded every four seconds, with the 
data at the end of each rod shown as a green dot . If a pressure limit threshold was set, data 
points will be magenta or red as the pressure threshold is approached or exceeded. In this 
case, the pressure limit threshold was set to 150 psi (see Job Information on page 39). 

 

Fluid Pressure Chart 

Fluid pressure from a P-T DataLog graphs in the somewhat jagged manner shown above; for 
a smoother representation, record a Drill DataLog concurrently (see Recording P-T Data on 
page 21). 

Data Points 

Blue Normal data points 

Red The point exceeded the maximum design pressure or force limits 

Magenta The point is within 5% of the entered design pressure or force 
limits. Edit design limits in the Job Information dialog box shown 
on page 39. 

Orange The maximum pressure (force) recorded up to that data point 

Data points within 15% of the maximum or high pressure are automatically selected for 
printing. To change this selection, right-click a data point in the list and selecting Print or 
Don't Print. 

Select multiple data points as noted in Removing Data Points on page 41. 

While you can remove data points on the charts, they will still display in the data points list 
marked as “-X” . This can be useful in cases where data was being collected while the 
machine was idle. The data can be restored to the chart at any time. 
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Data Flags 

Highlighted data points—points with a green circle behind them—had a data flag added by 
the receiver operator. Edit the color, label, and location of data flags in the Pressure-Tension 

Data Flags dialog box by clicking Data Flags  (menus Edit > Data Flags, or right-click 
the data point in the list and select Add Data Flag, or double-click an existing data flag). 

 

Pressure-Tension Data Flags Dialog Box 

When a fluid pressure transmitter is used during a pilot bore and the drill data file is also 
recorded, as shown above, a data flag is recorded with every new or deleted rod and marked 
as “NewRod” or “DelRod”, respectively. You can hide or display data flags for new and 
deleted rods on the pressure chart. 

Data flags manually added by the receiver operator, whether during a pilot bore or product 
pullback, are identified on the chart with the flag number that displayed when it was recorded, 
as shown on the pull force chart in the following section. 

Data flags added in LWD are called user flags. You can add comments to user flags and 
flags recorded during data collection. Flags recorded by the operator during data collection 
cannot be deleted.  

 

Note Don’t confuse data flags with utility flags. Utility flags do not apply to a 
pressure-tension file. 

Fields on the Pressure-Tension Data Flags dialog box include: 

Raw DP Index The data point number in the list of all data points; cannot be 
edited 

Show At Pressure The pressure at which the data flag will display; if the check box 
is cleared, the flag is not displayed on the chart 

Show At Force The force at which the data flag will display; if the check box is 
cleared, the flag is not displayed on the chart 

Draw Flag Use the check boxes and double-click the ellipses in the Draw 
Flag section to set shape properties and colors. 

Location data point will 

appear on chart Checked box indicates 
respective flag will not 

display on chart 
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Click Change to save changes to the file, then OK to exit. Just clicking OK closes the dialog 
box without saving changes.  

The edited flag appears on the chart as a circle using the color chosen in the Draw Flag 
section. 

The default caption consists of the number and type of the data flag. Enter a different caption 
in the Comment field, and change the caption angle using the Text Slope field. 

By default, the data flag displays at the pressure (force) that was measured when the flag 
was recorded or added. Use the Show At… check boxes to move the marker away from the 
measured data, if needed. 

Pull Force Chart  

The pull force chart only displays for TensiTrak jobs. It shows the product pull force 
measured at each data point. Data points will be yellow or red as a force threshold is 
approached or exceeded. In the case below, the force limit threshold was set to 40,000 lbf. 
(1915 kPa). 

 

Pull Force Chart 

Data points and data flags on the force chart can be manipulated using the same methods as 
for the pressure-tension chart (see previous section). 

See the DigiTrak F5 TensiTrak Operator’s Manual for complete instructions on using LWD 
software with the TensiTrak system. 

Drill DataLog Data Points 

Hover over a data point to display data recorded at that point. Click a data point on the profile 
chart to display its corresponding row in the data points table. Gaps in the data points 
indicate missing data. 

The colors and types of data points are as follows:  

Green Data Points The average pressure recorded during that rod and any rods 
previously recorded and deleted 

Blue Data Points The high pressure recorded during that rod and any rods 
previously recorded and deleted. This is the average plus 1 
standard deviation—this includes 84% of the pressure readings 
(assuming a normal distribution). Statistically, there will have 
been occasional spikes above this pressure. 

Gold Data Points The maximum pressure recorded during the rod and any rods 
previously recorded and deleted 

http://www.digitrak.com/customerservice/downloads.html
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Highlighted Data Points Points with a green circle behind them indicate that rods have 
been deleted during the data collection process. 

Pressure data cannot be deleted. If an overpressure event was recorded during a rod that 
was subsequently deleted, it will be merged into the data of the next recorded rod. Identifying 
the location of the overpressure event would require having recorded the pressure log and 
uploading it as a pressure-tension file, which would contain flags marking all recorded and 
deleted rods. 

Saving, Printing, and Sending Your LWD Job 

Saving Project Files 

To save your project, click Save  (menus File > Save). If the file has already been saved, 
it will re-save under its current file name and location. If the file has not yet been saved, name 
the file and select the save location in the Save As dialog box, then click Save. 

The default file name is DrillData#.dl5 for drill data files and Pressure-Tension#.dl5 for 
pressure-tension files. In both cases, “#” represents a number that starts at 1 and advances 
automatically as files are saved. 

To save an open file with a different file name or location, select File > Save As. Change the 
file name and location as desired, then click Save. 

To export a comma-separated value (*.csv) Unicode text file for use in a spreadsheet, click 
Export Spreadsheet  (menus File > Export Spreadsheet). 

DCI recommends saving a copy of each final job file in a separate folder as a backup. 

Printing and Previewing Project Files 

To print job data, click Print  (menus File > Print). DCI recommends selecting Landscape 
orientation using the Properties button. 

To preview pages before printing, click Print Preview  (menus File > Print Preview). On 
the preview window, click Print to reach the print dialog box or Close to return to the file. 

To edit printing properties such as the printer, paper size, and paper orientation, click Print 

Setup  (menus File > Print Setup). 

Page one of the print job contains job information such as location, client, and contractor 
information, along with the statistical data about the job and job comments. Page two 
contains profile and plan view charts. Page three and beyond list topography survey data and 
drill data. Deleted data points will not display. 
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Sending Project Files 

Your LWD project file can be opened by anyone who also has the DigiTrak LWD software. 

To send a report to a customer who does not have the LWD software, install a PDF print 
driver

1
, then print to this “printer” to create an electronic report viewable on any PDF reader. 

As an option to PDF, Microsoft Windows systems include a “Microsoft XPS Document Writer” 
in the list of available printers. Your customer will require Microsoft Internet Explorer to read 
this encapsulated postscript (XPS) format without an XPS reader. Please refer to 
http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-
Writer for additional information on using this format. 

Once you have your preferred PDF writer installed (or if you are using the XPS writer): 

1. Click Print  (menus File > Print). 

2. Use the Name drop-down list to select your PDF writer or Microsoft XPS Document 
Writer. 

 

3. Click Properties, select landscape orientation (recommended), and click OK to save 
the orientation and close the Properties dialog box. 

4. Click OK to print (generate) the file. 

5. Choose the folder where you want to save the file and enter a File Name. 

6. Click Save. 

Depending on your print settings, you may automatically see the generated PDF file, or you 
may need to find and open it to see it. Most users will find it convenient to send the PDF file 
to their customer as an attachment to an email. 

                                                      

1
  Popular options include Adobe Acrobat, CutePDF, Bullzip PDF, and FoxIt PDF; many of these have free versions. 

Select printer 
driver from this 

drop-down list 
Select Landscape 
orientation here 

http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer
http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer
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Appendix A - DataLog Menu Symbols 

The following menu options perform identically for both the standard Drill DataLog and 
pressure-tension (P-T) DataLog functions. Page numbers below refer to the first page the 
button is mentioned in this manual.  

Buttons are listed alphabetically. 

 

Append to an Existing Job – Continues adding data to an existing DataLog job. 
Select the job number from the list. Page 16. 

 

Confirm Delete – Appears after a request to delete jobs to confirm the deletion. 
Select to confirm deletion or select Exit to cancel deletion. Page 27. 

 

Create a New Job – Starts a new DataLog job. With the Drill DataLog function, you 

will be prompted to set up the job with rod lengths. With the pressure-tension 
DataLog function, the Locate screen will appear and logging will begin. Pages 10 

(drill) and 21 (P-T). 

 

Delete All Jobs – Deletes all jobs stored in the receiver. Page 26. 

 

Delete Job – Deletes the selected DataLog job(s) from the receiver. Also used in 

the Delete Job menu to select one job to delete. Page 26. 

 

Enable / Disable DataLog – When “Enabled, click to disable” shows, the icon is 

green, the DataLog function is enabled, and you can access DataLog menu options 
at the Locate screen. When “Disabled, click to enable” shows, the icon is red, the 

DataLog function is disabled, and no logging will occur. Page 4. 

 

Pause Job – Opens the receiver’s Main menu but keeps the job open with no data 

recording. Data continues recording on the current job number when you re-enter 
the Locate screen without powering the receiver down. Page 15. 

 

Set a Flag – Records a flag while a P-T DataLog job is running. Flags can be 

recorded at fixed intervals or at specific points along the bore path to help correlate 
physical locations with recorded data points. Page 22. 

 

Close Job – Saves and closes a DataLog job. A job can be viewed, appended to, 

and uploaded until it is deleted from the job list. Page 15. 

 

Upload Job – Uploads DataLog jobs to a computer with DigiTrak LWD software 

installed. The receiver can store a maximum of 50 DataLog jobs per file type (drill 
data or pressure-tension). Page 25. 
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The following menu options apply specifically to the Drill DataLog function.  

 

Add Survey Point – Records a surveyed value for the difference in elevation 

(reference elevation) between the start and end of the bore. This value will help 
provide a more accurate profile graph in the LWD software. Page 20. 

 

Record a Blank Rod – Logs a data point with no pitch or depth information; use 

when the receiver cannot be positioned within range of the transmitter. Page 13. 

 

Record Depth/Pitch – Logs the depth and pitch information at a front locate point 

(FLP) or locate line (LL) data point. This option is unavailable at the first rod data 
point and when pitch or depth information is not available. Page 13. 

 

Data at Partial Rod – Logs a data point after finishing a partial rod. Recommended 

when using long drill rods during significant pitch changes or to accurately plot small 
changes in topography. Page 14. 

 

Record Pitch Only – Logs only the pitch information at a data point; use when the 

receiver cannot be positioned over the FLP or LL. This option will be unavailable if 
pitch information is not available, in which case you must record a blank rod. 
Page 12. 

 

Set Up Job – Sets up a new job or appends data to an existing job. Only accessible 

when DataLog is enabled. If no Drill DataLog job has been started, this option can 
also be accessed from the Locate screen by holding the trigger and toggling right.  

 

View DataLog – Displays data for a specific job. Page 8. 

`  

View/Delete Rod Data – Shows all logged data points; lets you delete the last 

logged data point. Page 18. 
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Appendix B – Menus 

Menu Bar and Toolbar 

Many of the LWD menu commands are similar to those used in other Windows programs, 
and some have associated icons on the toolbar. Point the cursor at any icon in LWD for a 
tooltip describing its function. Icons or menu items that are grayed out do not pertain to the 
current DataLog file type. Page numbers below refer to the first page the command is 
mentioned in this manual. 

File Menu 

Command Icon Description 

New 
 

Create a new job (drill data, pressure-tension, or steering). Once a 
selection is made, a new blank job screen appears. Page 25. 

Open 
 

Open an existing job. Page 28. 

Save 
 

Save an open job. If the job has not yet been named/saved, this opens 
the same dialog box as Save As. Page 44. 

Save As  Save the current job to a specified file name and folder. Page 44. 

Print  Print the job. Page 44. 

Print Preview  Display the job onscreen as it will appear printed. Page 44. 

Print Setup  Select options such as a printer, paper size and orientation. These 
options are usually also available on a Windows Print dialog box under a 
button called Properties. Page 44. 

Import Eclipse 
Data 

 Import an Eclipse DataLog file (*.dld) or Eclipse TensiTrak file (*.ttd). 

Export 
Spreadsheet 

 Export a comma-separated value (*.csv) text file for use in spreadsheet 
software. Page 44. 

Upload Control  Link to a DigiTrak receiver to upload files. Page 25. 

File 1, 2…  Open a recently opened file. 

Exit  Exit the DigiTrak LWD program. 

Edit Menu 

Command Icon Description 

Site 
Information  

Enter and edit the location, contact information, and comments that 
display in the Site Information box in the upper left corner of the program. 
Shortcut: double-click the site information box. Page 29. 

Display Units 
 

Select the depth, pitch, temperature, and force/pressure units displayed 
on the LWD charts. The depth unit setting in the receiver will determine 
the units displayed. Page 28. 

Job 
Information  

View and edit job details including rod length, survey point information for 
drill data files, and information about the product being installed for 
pressure-tension files. This dialog box displays immediately after 
uploading a DataLog file. Shortcut: double-click the Job Information box. 
Page 30. 
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Command Icon Description 

Profile  
Chart 
Annotations 

 
Make comments and insert drawings to appear on the profile chart. 
Shortcut: Shift+drag a box on the chart. Page 33. 

Pressure Chart 
Annotations  

Make comments and insert drawings to appear on the pressure chart. 
Shortcut: Shift+drag a box on the chart. Page 33. 

Force  
Chart 
Annotations 

 
Make comments and insert drawings to appear on the force chart. 
Shortcut: Shift+drag a box on the chart. Page 33. 

Profile  
Chart 
Properties 

 
Adjust the scaling of the Profile Chart. Page 34. 

Pressure Chart 
Properties  

Adjust the scaling of the Pressure Chart. Page 34. 

Force  
Chart 
Properties 

 
Adjust the scaling of the Force Chart. Page 34. 

Utility Flags 
 

Add, change, or delete flags and data regarding utilities. Page 38. 

Data Flags 
 

Change or delete P-T data flags. Page 42. 

View Menu 

Command Icon Description 

Toolbar  Show or hide the toolbar. 

Status Bar  Show or hide the status bar. 

Bluetooth 
Device List    

Show a list of registered Bluetooth devices. Page 24. 

Window Menu 

Command Icon Description 

New Window  Open the current file in a new window. 

Cascade  Arrange windows in an overlapped fashion. 

Tile  Arrange windows in non-overlapped tiles. 

Arrange Icons  Arrange icons of minimized windows. 

Window 1, 2…  Go to specified window. 

Help Menu 

Command Icon Description 

Help Topics 
 

An index of Help topics. Page 28. 

About DigiTrak 
LWD 

 Displays the version number of the DigiTrak LWD software. 
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LIMITED WARRANTY 

Digital Control Incorporated ("DCI") warrants that, when shipped from DCI, each DCI product (other than software products) will conform to 
DCI’s current published specifications in existence at the time of shipment and will be free, for the warranty period (“Warranty Period”) 
specified below, from material defects in materials and workmanship. In addition, DCI warrants that each DCI software product will perform in 
substantial accordance with the specifications set forth in the documentation for such software for the Warranty Period specified below. The 
following limited warranty (“Limited Warranty”) is made solely to and for the benefit of the first end-user (“User”) purchasing the DCI product 
from either DCI or a dealer expressly authorized by DCI to sell DCI products (“Authorized DCI Dealer”) and is not assignable or transferable. 

The foregoing Limited Warranty is subject to the following terms, conditions and limitations: 

1. A Warranty Period of twelve (12) months shall apply to the following new DCI products: receivers/locators, remote displays, battery 
chargers and rechargeable batteries, and software programs and applications. A Warranty Period of ninety (90) days shall apply to all 
other new DCI products, including transmitters and accessories. A Warranty Period of ninety (90) days shall also apply to services 
provided by DCI, including testing, servicing, and repairing an out-of-warranty DCI product. The Warranty Period shall begin from the 
later of: (i) the date of shipment of the DCI product from DCI, or (ii) the date of shipment (or other delivery) of the DCI product from an 
Authorized DCI Dealer to User. 

2. If a DCI product (excluding software products) does not perform as warranted during the Warranty Period, DCI will inspect the product 
and if DCI determines such product to be defective, DCI will, at its sole option and discretion, either repair or replace the product. If a 
software product does not perform as warranted during the Warranty Period, DCI will, at its sole option and discretion, either bring the 
defective software into material compliance with the specifications for such software or refund the purchase price paid for the defective 
software. THE FOREGOING ARE USER’S SOLE AND EXCLUSIVE REMEDIES FOR BREACH OF THIS LIMITED WARRANTY. All 
warranty inspections, repairs and adjustments must be performed either by DCI or by a warranty claim service authorized in writing by 
DCI. All warranty claims must include proof of purchase, including proof of purchase date, identifying the DCI product by serial number, 
and be submitted before the end of the Warranty Period. 

3. The Limited Warranty shall only be effective if: (i) within fourteen (14) days of receipt of the DCI product, User registers the DCI product 
with DCI through its product registration website at access.DigiTrak.com; (ii) User makes a reasonable inspection upon first receipt of 
the DCI product and immediately notifies DCI of any apparent defect; and (iii) User complies with all of the Warranty Claim Procedures 
described below. 

What is not covered 

This Limited Warranty excludes all damage, including damage to any DCI product, due to: failure to follow DCI’s operator’s manual and other 
DCI instructions; use of a DCI product outside the specifications for which the DCI product is designed (including, without limitation, 
temperature); abuse; misuse; neglect; accident; fire; flood; Acts of God; improper applications; connection to incorrect line voltages and 
improper power sources; use of incorrect fuses; overheating; contact with high voltages or injurious substances; use of batteries or other 
products or components not manufactured or supplied by DCI; or other events beyond the control of DCI. This Limited Warranty does not 
apply to any equipment not manufactured or supplied by DCI nor, if applicable, to any damage or loss resulting from use of any DCI product 
outside the designated country of use. User agrees to carefully evaluate the suitability of the DCI product for User’s intended use and to 
thoroughly read and strictly follow all instructions supplied by DCI (including any updated DCI product information which may be obtained 
from the DCI website). In no event shall this Limited Warranty cover any damage arising during shipment of the DCI product to or from DCI. 

User agrees that the following will render the above Limited Warranty void: (i) alteration, removal or tampering with any serial number, 
identification, instructional, or sealing labels on the DCI product, or (ii) any unauthorized disassembly, repair or modification of the DCI 
product. In no event shall DCI be responsible for the cost of or any damage resulting from any changes, modifications, or repairs to the DCI 
product not expressly authorized in writing by DCI, and DCI shall not be responsible for the loss of or damage to the DCI product or any other 
equipment while in the possession of any service agency not authorized by DCI. 

DCI does not warrant or guarantee the accuracy or completeness of data generated by HDD locating systems. The accuracy or 
completeness of such data may be impacted by a variety of factors, including (without limitation) active or passive interference (including 
from salt water) and other environmental conditions, failure to calibrate or use the device properly and other factors. DCI also does not 
warrant or guarantee, and disclaims liability for, the accuracy and completeness of any data generated by any external source or derived 
from data generated by any external source that may be displayed on a DCI device, including (without limitation) data received from any 
HDD drill rig. 

DCI reserves the right to make changes in design and improvements upon DCI product from time to time, and User understands that DCI 
shall have no obligation to upgrade any previously manufactured DCI product to include any such changes. 

THE FOREGOING LIMITED WARRANTY IS DCI’S SOLE WARRANTY AND IS MADE IN PLACE OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE, IMPLIED WARRANTY OF NON-INFRINGEMENT, AND ANY IMPLIED WARRANTY ARISING FROM 
COURSE OF PERFORMANCE, COURSE OF DEALING, OR USAGE OF TRADE, ALL OF WHICH ARE HEREBY DISCLAIMED AND 
EXCLUDED. If DCI has substantially complied with the warranty claim procedures described below, such procedures shall constitute User’s 
sole and exclusive remedy for breach of the Limited Warranty. 

mailto:dci@digital-control.com
http://www.digitrak.com/
http://access.digitrak.com/
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Limitation of remedies and liability 

In no event shall DCI or anyone else involved in the creation, production, or delivery of the DCI product be liable for any damages 
arising out of the use or inability to use the DCI product, including but not limited to indirect, special, incidental, or consequential 
damages, or for any cover, loss of information, profit, revenue or use, based upon any claim by User for breach of warranty, 
breach of contract, negligence, strict liability, or any other legal theory, even if DCI has been advised of the possibility of such 
damages. In no event shall DCI’s liability exceed the amount User has paid for the DCI product. To the extent that any applicable 
law does not allow the exclusion or limitation of incidental, consequential or similar damages, the foregoing limitations regarding 
such damages shall not apply. 

This Limited Warranty gives you specific legal rights, and you may also have other rights which vary from state to state. This Limited 
Warranty shall be governed by the laws of the State of Washington. 

Warranty claim procedures 

1. If you are having problems with your DCI product, you must first contact the Authorized DCI Dealer where it was purchased. If you are 
unable to resolve the problem through your Authorized DCI Dealer, contact DCI’s Customer Service Department in Kent, Washington, 
USA at 1.800.288.3610 (or, for international markets, the corresponding telephone number for that market) between 6:00 a.m. and 6:00 
p.m. Pacific Time and ask to speak with a customer service representative. Prior to returning any DCI product to DCI for service, you 
must obtain a Return Merchandise Authorization (RMA) number. Failure to obtain an RMA may result in delays or return to you of the 
DCI product without repair. 

2. After contacting a DCI customer service representative by telephone, the representative will attempt to assist you in troubleshooting 
while you are using the DCI product during actual field operations. Please have all related equipment available together with a list of all 
DCI product serial numbers. It is important that field troubleshooting be conducted because many problems do not result from a 
defective DCI product, but instead are due to either operational errors or adverse conditions occurring in User’s drilling environment. 

3. If a DCI product problem is confirmed as a result of field troubleshooting discussions with a DCI customer service representative, the 
representative will issue an RMA number authorizing the return of the DCI product and will provide shipping directions. You will be 
responsible for all shipping costs, including any insurance. If, after receiving the DCI product and performing diagnostic testing, DCI 
determines the problem is covered by the Limited Warranty, required repairs and/or adjustments will be made, and a properly 
functioning DCI product will be promptly shipped to you. If the problem is not covered by the Limited Warranty, you will be informed of 
the reason and be provided an estimate of repair costs. If you authorize DCI to service or repair the DCI product, the work will be 
promptly performed and the DCI product will be shipped to you. You will be billed for any costs for testing, repairs and adjustments not 
covered by the Limited Warranty and for shipping costs. In most cases, repairs are accomplished within 1 to 2 weeks. 

4. DCI has a limited supply of loaner equipment available. If loaner equipment is required by you and is available, DCI will attempt to ship 
loaner equipment to you by overnight delivery for your use while your equipment is being serviced by DCI. DCI will make reasonable 
efforts to minimize your downtime on warranty claims, limited by circumstances not within DCI’s control. If DCI provides you loaner 
equipment, your equipment must be received by DCI no later than the second business day after your receipt of loaner equipment. You 
must return the loaner equipment by overnight delivery for receipt by DCI no later than the second business day after your receipt of the 
repaired DCI product. Any failure to meet these deadlines will result in a rental charge for use of the loaner equipment for each extra 
day the return of the loaner equipment to DCI is delayed. 

Product demonstrations 

DCI personnel may be present at a jobsite to demonstrate basic usage, features, and benefits of DCI products. User acknowledges that DCI 
personnel are present only to demonstrate a DCI product. DCI does NOT provide locating services or other consulting or contracting 
services. DCI does not assume any duty to train User or any other person, and does not assume responsibility or liability for the locating or 
other work performed at a jobsite at which DCI personnel or equipment are or have been present. 

 




